WASN'T IN NZ OR OCLC WHEN
ORDERED? AND IT IS NOW?
HERE'S HOW YOU PROPERLY

MERGE IT!




Topics being covered in Today’s Training Session

1. How to edit brief bib records created for ordering to include the OCLC #

2. What to do after the brief bib record has been updated with an OCLC #
a) Export from OCLC
b) Merge with an existing NZ bib records when a match exists

3. Troubleshooting what to do if a duplicate bib record is created by mistake in the NZ
when updating a brief bib record




UPDATING A NZ BRIEF BIB WHEN
AN OCLC MASTER RECORD NOW
EXISTS




Updating a NZ brief bib when an OCLC master record Now EXists

1. Search OCLC for the bib record

Search WorldCat

2. CO py the OC LC H Command Line Search

Enter numeric, derived, keyword, or scan search here...

Keyword/Numeric Search

Search for- [~ Retain Search
| | | Title (ti)
OCLC | 1122799125 | No holdings in ZBM - 4 other holdings o ]| ] [Fubister p5)
|Books ~| Recstst ¢ Entered 20191018 Replaced 201911
Type a ELvi 8 Srce Audn cid Lang eng [AND - | (9781611808049 | |ISBN (bn;)
Blvl m Form Conf 0 Biog MRec Ctry  cou
Cont b GPub LIE 0 Indx 1 Language: Format Internet
Desc i lils Fest 0 DiSt s Dates 2020 . [1Any] - j 1Any] ~| iAo
Source: Microform: Years: Material Type:
Pro T T T2oms0ez343 [[Any] =l iAoy E[ | ([Any]
040 DLC #b eng e rda $c DLC $d BDX +d OCLCO +d OCLCF
020 9781611808049 $q (rade paperback) ™ Apply Language of Cataloging Limiter Search Results:
020 1611808049 |Eng|ish [ Display using GLIMIR clustering
042 pcc Enter Diacritics... | Expand/Collapse |
050 0 0 B132Y6+bF5592020
082 0 0 181454223 Seftings... q’Tl Cancel | Clear Search | Help |
090 +b
049 ZBMM

100 1 Einger, Alan, $d 1946- e author.

245 1 4 The genius ofyoga : b how yogic meditation can unlock your innate brilliance [ ¢ Alan Finger and Peter Ferkd
250 First edition.

263 2006

264 1 Boulder, Colorado : £b Shambhala. #c [2020]




Updating a NZ brief bib when an OCLC master record Now EXists

3. Perform a repository search in the IZ for the brief bib in AlIma

‘ W ISBN ~ 9781611808049 ﬁ.n |

4. Click Edit Record from the brief bib record

%+ Institution &% Network 4L Community

Sortby: Rank *  Secondary Sortby: Rank - Expand> [
1 A THE GENIUS OF YOGA ﬁ EditRecord  Holdings

Book {Book - Physical} By Finger, Alan (Shambhala 2020) Language: English ™ Orders: 1

Creation Date: 12/18/2010 17:42.44 EST ISBN: 9781611808049 MMS ID:

Modification Date: 12/18/2019 17:42:44 EST 9903503571048

Physical (1) (Other details




Updating a NZ brief bib when an OCLC master record Now EXxists

5. Click Edit>Add Field ws - 2 3
6. Add MARC field O35 with the OCLC # as follow: Alma he @ Add Field v F8
a) 035 _ _ $%a (OCOLC)##H#HH#HH#HH#H (Bibiogy] ¢ Remove Fleld Ce
Add Subfield F9
7. Click Save and Release (Ctrl+Alt+R) “OF @ Add Local Extension Cri+L
0o Alternate Graphic Representation  p
“”I . =
File « Edit - Tools ~ "~ ﬁl E’a -&'E: E i}

You have 4 warning(s) in your record - Draft auto-saved at 5:54:35 PM.

Bibliographic | Working on - THE GENIUS OF YOGA (991059020316204801), Created by adminpsb@015UNY_ESC

LDR 00265nam#a220010971#4500
001 991059020316204301

005 20191218174159.0

008 19121852020 &4 thociiria#0 0 0#0%engid
020 $5a 9751611808049

035 $5a (QCoLC)1122799125 |

100 1 535a Finger, Alan
245 $3a THE GENIUS OF YOGA
264 1 %%b Shambhala $%c 2020




Updating a NZ brief bib when an OCLC master record Now EXists

8. Return to OCLC and make sure the export X

RDA | Record Display | Speling | Toolbar | Z39.50 |

|S a p p | |ed fo r th e N Z (fo r C a m p u Se S w |th Access | Authorizations | Batch | Classiy | Derive RecoFonts | General | Intemational | My Status | Printing |

Destination

a n IZ a n d N Z ex po rt) IEp File:(Prompt for filename) A

Gateway Export: Westchester |Z export
Gateway Export:ESC Sandbox |2
Gateway Export:ONE 1Z export

a) Tools>Options oy Comomrs S

3gLEW d XDOI ANUD X
I Gatewav Export:SUNY NZ Export

C||Ck on the EXpOFt tab Creste. |  Edit. Delete
CIle on the NZ export Record Characteristics... Field Export Optians... |

™ Allow export of workforms

b)
C)
d) Click Apply B
e)

Options b bibliographic records that include unlinked non-Latin script fields

CI i C k Close RDA ] Record Display ] Spelling ] Tcolbar] Z3‘350]

Access ] Autharizations I Batch ] Classify ] Derive Record Forts ] General ] Intemational ] My Status ] Prirting ]

et
File:{Prompt for filename) A OK | Cancel Apply ‘h |

EP Gateway Export: Westchester |2 export
Gateway Export:ESC Sandbox 12

Gateway Export:OME |Z export
Gateway Export:Oneonta |Z Export
Exj

Create... | Edit... Delete

Record Characteristics. .. Field Export Options... |

[~ Allow export of workforms
[~ Display report for immediate export results

[~ Warn before exporting biblicgraphic records that include unlinked non-Latin script fields

d Close | | Apply Help




Updating a NZ brief bib when an OCLC master record Now EXists

9. Click on Action>Export (F5) or click the Export icon

Zh File Cataloging  Authorities  Edit  Action  Batch  View  Tools  Window  Help

B Tt Stings + 5 User Tool ~ - SREAIRHA ¢ 8 R ¥ Fammhe S
|OCLC 1122799125 MNo holdings in ZBM - 4 other holdings
|Books j Rec stat C Entered 20191018 Replaced 20191107012222.2
Type a Elvl 8 Srce Audn Ctrl Lang eng
Blvl m Form Conf 0 Biog MRec Ciry  cou
Cont b GPub LitF 0 Indx 1
Desc j 11 Fest 0 DtSt s Dates 2020

ID‘ID' | |2msn~42343

040 DLC #b eng e rda $c DLC +d BDX +d OCLCO +d OCLCF
020 9781611808049 g (trade paperback)

020 1611808049

D42 pcc

050 0 0 B132.Y6 +bF5592020

082 0 0 181/454223

090 +b

049 ZBMM

100 1 Finger, Alan, +d 1946- e author.

245 1 4 The genius of yoga : b how yogic meditation can unlock your innate brilliance [ #£c Alan Finger and Peter Ferko.




Updating a NZ brief bib when an OCLC master record Now EXists

10. Return to Alma and perform a repository search for the updated brief bib record

ISBN ~ 9781611808049 ft~ n Advanced v

All Titles (1-10of 1) 0781611808049

Save Query

M Institution o' Network AL Community

Sort by : Rank ~ Secondary Sort by : Rank ~ Expand ~ [ ]

1 & The genius of yoga : how yogic meditation can unlock your innate brilliance / Alan Finger and Peter Ferko. P Edit Record  Holdings
Book {Book - Physical} text; unmediated; volume By Finger, Alan, Language: English = Orders: 1
(Boulder, Colorado : Shambhala, [2020]) ISBN: 0781611808049 and others MMS ID:

Subject: Meditation. Mindfulness (Psychology) Yoga. Record number: (OCoLC)1122799125 996350357104825
Creation Date: 12/18/2019 17:42:44 EST ¥

Modification Date: 12/18/2019 18:10:22 EST
Edition: First edition.

Physical (1) Other details




MERGING A NZ BRIEF BIB WHEN
AN EXISTING NZ MASTER BIB
RECORD




Merge Behavior and When to Merge NZ Brief Bib Records

m To merge bib records they must be in the same zone

m o merge bib records you need to have a primary and a secondary bib record

The primary bib record is the record that is opened first in the MD Editor and it
displays on the left-side of the split screen of the MD Editor

The secondary bib record is the record that is opened second in the MD Editor
and it displays on the right-side of the split screen of the MD Editor

m Merging occurs on the primary bib record
m When to merge a NZ brief bib record with a NZ full bib record:
If a matching master bib record exists in the NZ after a brief bib was created for

ordering
A brief bib was accidentally created for ordering when a NZ full bib already exists

in the NZ




Possible Workflows to Merge a NZ Brief Bib with an NZ Bib Record

1. Relink from POL

Roles Required:

* Purchasing Operator
e Cataloger

e (Cataloger Extended

Pros:
 Moves the POL and associated inventory
to the master record in the NZ

Cons:

e Call number in the holdings record needs
to be updated

» Brief bib record needs to be unlinked from
the NZ

* Brief bib needs to be deleted in the 1Z

 NZ bib record MMS ID/ Title needs to be
reported to the NZ Coordinator to be
deleted

2. Merge Record & Combine Inventory

Roles Required:
» Cataloger
e (Cataloger Extended

Pros:

* Retains the POL and associated inventory
* Deletes the secondary bib record

e Other campus holdings are merged

* No duplicate bib records are created

Cons:

e Call number in the holdings record needs to
be updated

 Change Bib Reference for the POL

* Records can be merged incorrectly if the
incorrect merge routine is used




Possible Workflows to Merge a NZ Brief Bib with an NZ Bib Record

3. Copy & Overlay -3¢ DO NOT USE

Roles Required:
e Cataloger
e (Cataloger Extended

Pros:

e Overlays all the MARC fields in brief bib
with the secondary record’s MARC fields

* Retains POL and associated inventory

Cons:

* Does not merge inventory

* Creates a duplicate bib record in the NZ

* Does not retain local notes*

e Call number in the holdings record needs
to be updated

4. Copyand Merge -3¢ DO NOT USE

Roles Required:

Cataloger
Cataloger Extended

Pros:

Merges MARC fields in the primary and
secondary records

Maintains local notes

Retains POL and associated inventory

Cons:

Brief bib MARC fields are retained

Does not merge inventory

Creates a duplicate bib record in the NZ

Call number in the holdings record needs to
be updated

Leaves user in a loop matching to the original
full NZ bib record




Copy & Overlay Example - DO NOT USE

File ~ Edit~  Tools ~ | < Exit

Description was filed successfully. Matches(1)

Working on - THE YOGA TEACHER MEN_(991059020318404801)) Created by
Bibliographic| adminpsb@01SUNY_ESC (12/17/2019 12:34:03 EST), Modified by adminpsb@01SUNY_ESC

(12/17/2019 12:34:47 EST) 1 The yoga teacher mentor §(991059020318504801) | View  Edit
LDR 00289nam#a22001097u=4500 By Glenny, Jess, (Book Jessica Kingsley Publishers,, London ;, 2020)
001 991059020316404801 Prl mary ReCO rd glﬁ)?é!t?i’iiftiichers_ ‘Yoga-—-Study and teaching.
005 20191217123447.0 Other System Number: (OCoLC)on1084631063, (OCoLC)1084631063,
008 191217s2020##cra####00040#engHd (OCol C)1097677622
020 $5a 9781787751262
035 $5a (QCoLC)1084631063 P
m 100 1 5aGLENNY JESS Secondary Record
245 $5%a THE YOGA TEACHER MENTOR

264 1 $%b Jessica Kingsley Publishers, $5c 2020

| mn90 $5a TEST COPY & QVERLAY. | %

= Information

The content of record (991059020317804801) has been
updated with that of record (991059020318104801). Note
that record (391059020318104801) has no holdings linked
to if, so it can be deleted.

Misleading Info!

Close




Copy & Overlay Example - DO NOT USE

File ~  Edit~  Tools ~ = = B =3 =
Alma has attempted to link the bib headings to authority records while loading the record. Loading the re
Bibliographic Working on - The yoga teacher men|{991 3'59'32[)318-10483'1}' Created by adminpsb@01SUNY_|

| LDR 01105cam#a22003618i#4500

001 991059020318404501

005 20191217123857.0

008 19020120208 enlke R 0004 0Hen g

010 $5a ##2019004539

019 $%a 1097677622

020 $%a 9781787751262 Copy & Overlay
020 $5a 1787751260

020 $5z 9781787751279 (ebook)

035 $%a (OColLC)1084631063 5%z (OCoLC)10976TTE22

035 $%a (OColLC)on1084631063

040 $%a DLC $5b eng $%e rda $3c DLC $$d OCLCO $5d OCLCF $5d ¥YDX $5d BDX
042 $%a pcc

049 $%a ZBMM

050 0 0 $5a RAT31.7 $3b .G54 2020
082 0 0 $5a613.7/046076 $32 23

o 100 1 $5a Glenny, Jess, $%e author.
245 1 4 %%a The yoga teacher mentor / $5c Jess Glenny.
263 $%a 2001
264 1 %5%a London ; $%a Philadelphia : $%b Jessica Kingsley Publishers, $%c 2020.
300 $%a pages cm
336 $%a text $5b tat $52 rdacontent
337 $5a unmediated $$b n $52 rdamedia =
338 $%a volume $%b nc 5%2 rdacarrier Local Nc_)te IS
A 650 o $%a Yoga $%x Study and teaching. not retal nEd
A B50 o0 %5a Yoga teachers.
A 650 7 %$%a Yoga $5x Study and teaching. $%2 fast $50 (OColLC)fst01182879
A B50 7 %5%a Yoga teachers. 552 fast $50 (OColLC)fst01920756

994 $%a CO 55b ZBM




Copy & Overlay Example - DO NOT USE

M Institution o Network Xt Community
Copy & Overlay - Inventory Does
Sort by : Rank ~ Secondary Sort by : Rank - Expand - &
Not Merge
The yoga teacher mentor / Jess Glenny. EditRecord  Order
Book {Book - Physical} text; unmediated; volume By Glenny, Jess, ISBN: 9781787751262 and others Language: English
(London ; Jessica Kingsley Publishers, 2020.) Record number: (OCoLC)1084631063 MMS ID:
Subject: Yoga—Study and teaching. Yoga teachers. 991059020318404807]
Creation Date: 12/17/2019 12:34:03 EST
Modification Date: 12/17/2019 12:38:57 EST Secondary Record NZ Fu” Blb
Held by (1) Other details ReCOFd

SUNY Geneseo

2 #4 The yoga teacher mentor / Jess Glenny. Edit Record  Order
Book {Book - Physical} text; unmediated; volume By Glenny, Jess, ISBN: 9781787751262 and others Language: English
(London ; Jessica Kingsley Publishers, 2020.) Record number: (OCoLC)1084631063 MMS ID:
Subject: Yoga—-Study and teaching. Yoga teachers. ¥ 991059020318304801
Creation Date: 12/17/2019 13:03:57 EST
Modification Date: 12/17/2019 13:06:50 EST . .

S5 onewene | PYIMary Record - Former Brief
- Bib Record

My Institution




Copy & Merge Example - DO NOT USE

File ~  Edit ~ Tools ~ B 32 Exit

You have 4 warning(s) in your record - Draft saved at 2:32:33 PM. Matches(1)

Working on - THE YOGA TEACHER MEN [9910590203173804207), [Created by
Bibliographic| adminpsb@015UNY_ESC (12/18/2019 105 : ¥ adminpsb@01SUNY_ESC

(12/18/2019 14:30:57 EST) The yoga teacher mentor JI{9910590203181048CI‘1} View  Edit
0028%nam#a22001097 #4500 By Glenny, Jess, (Book Jes% i i =bndon ;, 2020)

—

LoR _ . ISBN: 1787751260 Copy & Overlay
001 991059020317804807 Prlmary Record Subjects: Yoga teachers., Yoga--Study and teaching. c
005  20191218143057.0 Other System Number: (OCoLCJon1084631063, (OCoLC)1084631063, opy & Merge ™
008 191218520208 #ockri#00 0#0#eng#d (OColLC)1097677622 Merge Preview
020 $5a 9781787751262 Records
035 $%a (OCoLC)1084631063
A 100 1 $%a GLENNY. JESS
245 $%a THE YOGA TEACHER MENTOR Secondary Record
264 1 $%b Jessica Kingsley Publishers, $3c 2020
=90 $5a LOCAL NOTES TO TEST COPY & MERGE

= Information

The content of record (991059020317804801) has been
updated with that of record (991059020318104801). Note
that record (391059020315104301) has no holdings linked
toit, so it can be deleted.

Misleading Info!

Close




Copy & Merge Example - DO NOT USE

File ~ Edit ~ Tools ~ = [ B, = - fiii]

You have & warning(s) in your record

Working on - THE YOGA TEACHER MEN (991059020318804801), Created by adminpsb@01SUNY_ESC (12/17/201

| LDR 00289nam#a22001097u#4500
001 991059020318904801
005 20191217111653.0
008 19121 Ts2020fFHhodqRaE A0 0 0#0#eng#d
010 $5a ##2019004539
019 $3a 1097677622 Copy & Merge

{020 $5a 9781767751262 |

035 $%a (OCoLC)1084631063 $%z (OCoLC)109767TE22
035 $Sa (OColClon1084631063
040 $%a DLC $%b eng $%e rda $3c DLC $%d OCLCO $%d OCLCF 3%d YDX $5d BDX
042 $%a pcc
049 $5a ZBMM
o500 0 $%a RATE1.7 3%5b G54 2020
082 0 0 $5a6137/046076 552 23 Retains MARC Fields

S TN = A from the Primary
245 3%a THE YOGA TEACHER MENTOR o o
—— l Record - Brief Bib

I 264 1 $5b Jessica Kingsley Publishers, $%c 2020 I
300 $%5a pages cm
336 $%a text $5b txt $52 rdacontent
337 $5a unmediated $5b n 352 rdamedia
5 338 $%a volume $3b nc $%2 rdacarrier
I 590 3%a LOCAL NOTES TO TEST COPY & I"a'IERGEI
650 0 $%a Yoga $5x Study and teaching.
650 0 %%a Yoga teachers.
650 7 %%a Yoga $5x Study and teaching. $52 fast $50 (OCoLC)fst01182879
&50 7 3%a Yoga teachers. $52 fast 330 (OColLC)fst01920756
—




Copy & Merge Example - DO NOT USE

The yoga teacher mentor / Jess Glenny. | Copy & Merge - |nvent0ry Does Not Merge Edit Record  Order
Book {Book - Physical} text; unmediated; volum - - = S 2 P Eergeage=taahsh

(LO"IdOn ; Jessica KIngSlE}’ PU:”S"IE’S. 2020] Record number: (OCDLD]' 084631063 MMS ID:
Subject: Yoga—Study and teaching. Yoga teachers. ¥ 991059020318104801

Creation Date: 12/17/2010 13:34:48 EST
Modification Date: 12/17/2019 13:39:10 EST

Secondary Record - NZ Master Record

Held by (1) Other details

2 #4 THE YOGA TEACHER MENTOR Edit Record  Order
Book {Book - Physical} text; unmediated; volume By GLENNY, JESS ISBN: 9781787751262 Language: English

(Jessica Kingsley Publishers, 2020) Record number: (OCOLC)1084631063 MMS ID:
Subject: Yoga—-Study and teaching. Yoga teachers. ¥ 907059020317804801

Creation Date: 12/18/2019 10:40:56 EST Copy & Merge

Maodification Date: 12/18/2019 14:35:19 EST

Held by (1) Other details Record




MERGE RECORD & COMBINE
INVENTORY FOR NZ BRIEF BIB
RECORDS WORKFLOW




Merge Record & Combine Inventory Workflow

1. Search OCLC for the bib record and copy the OCLC #

2. Perform a repository search for the brief bib:
a) Search by ISBN/Title/Author

b) Use an advanced search to limit the result to NZ physical records

Alltitles ¥ [Eslal=N # Institution @ & Network 28 Community X

ISBN v Contains Keywords v 9781787751262 O G X

LUDE OR Linked Institution v Not Equals Community - O X

Clear form Search

3. Click Edit Record to open the brief bib record in the MD Editor

M Institution o Network At Community
Sort by : Rank ~ Secondary Sort by : Rank ~ Expand « [ o]
& THE YOGA TEACHER MENTOR # Edit Record Holdings
Book {Book - Physical} By Glenny, Jess (Jessica Kingsley Publishers, Language: English = Orders: 1
2020) ISBN: 0781787751262 MMS ID:
Creation Date: 12/16/2019 11:54:32 EST Record number: (0CoLC)1084631063 996350359804825

Modification Date: 12/16/2019 11:54:32 EST

Physical (1) Other details




Merge Record & Combine Inventory Workflow

4. Click Edit>Add Field (F8)

File + | Edit~ | Tools ~ =

Alma he € Add Field h F8

Remove Field Cirl+F6
(Bibliogr X Remove Fie I on

Add Subfield FS

| LDF
00

00! Add Rule

€ Add Local Extension Ctrl+L

A W (Crmmbie Ean P
Alternate Graphic Kepresenltation

oo  Enhance the Record Cirl+Al+E
021 Expand from Template  Cirl+E

CA4

03! Generate Author Number F4

5. Add MARC field O35 with the OCLC # as follow:
a) 035 _ _ $%a (OCOLC)#####HHHHH

LDR 00323nam#a22001217u#4500
001 991059020319304801
005 201912161345934.0
nos 19121620 2 0aoarERRRER# 0 0 0#0#eng#d
020 $%a 9781787751262
$5a (OColLC)1084631063
A 100 1 $%a Glenny, Jess




Merge Record & Combine Inventory Workflow

6. Click on the Save icon (Ctrl+S)

File - Edit ~ Tools ~ ﬂ ==Y B = = i}

You have

4 warning(s) in your record - Draft auto-saved at 1:50:153 PM.

ibliographic Working on - THE YOGA TEACHER MEN (991059020319304801), Created by adminpsb@01SUNY_ESC (12M16/
LDR 00323nam#a22001217u#4500
001 $91059020319304801
005 20191216134934.0
008 191216520 20000 0#0#eng#d
020 $%a 9781787751262
035 $5a (DColC)1084631063]
A 100 1 $%a Glenny, Jess

7. Click Yes when the Confirmation required pops up asking: “Matched record/s exist
in the catalog, do you want to view them before saving?”

Confirmation required

Matched recordis exist in the catalog,
F  doyou want to view them before saving?

* Yes No




Merge Record & Combine Inventory Workflow

8. The NZ bib record will open on the right-side of the MD editor

File = Edit ~ Tools ~

You have 4 warning(s) in your record - Draft saved at 2:01:42 PM.

Working on - THE YOGA TEACHER MEN (9591059020319304801), Created by
Bibliographic | adminpsb@01SUNY_ESC (12/16/2019 11:52:00 EST), Modified by adminpsb@01SUNY_ESC
(12/16/2019 14:01:22 EST)

LDR 0028%nam#a22001097u#4500
001 991059020319304801
005 20191216140122.0
003 191216520208 hodt R rHAA0 0 0#0#eng#d
020 $%a 9781787751262
035 $5a (OCoLC)1084631063
A 100 1 $%a Glenny, Jess
245 $%a THE YOGA TEACHER MENTOR
264 1 $%b Jessica Kingsley Publishers, $5c 2020

|
Matches(1)
The yoga teacher mentor / (991059019518104801) View  Edit

By Glenny, Jess, (Book Jessica Kingsley Publishers,, London ;, 2020)
ISBN: 1787751260

Subjects: Yoga teachers., Yoga—Study and teaching

Other System Number: (OColC)on1084631063, {OCoLC)1084631063
(OCoLC)1097677622

NZ Bib Record

Exit

9. Click View from the NZ bib record on the right-side of the MD Editor to make sure it

is the correct bib record

File = Edit - Tools ~

You have 4 warning(s) in your record - Draft saved at 2:01:42 PM.

Working on - THE YOGA TEACHER MEN (991059020319304801), Created by

adminpsb@01SUNY_ESC (12/16/2019 11:52:00 EST), Modified by adminpsb@01SUNY_ESC
(12/16/2019 14:01:22 EST)
LDR 00289nam#a22001097u#4500
001 991059020319304801
005 20191216140122.0

191216520205 Hhoa R0 00#0#engid

008

L3
('3

&

Matches(1)

The yoga teacher mentor / (991059019518104801)
By Glenny. Jess, (Book Jessica Kingsley Publishers., London ;, 2020)
ISBN: 1787751260

Subjects: Yoga teachers., Yoga—Study and teaching.

Other System Number: (OColLC)on1084631063, (OCoLC)1084631063,
(OCoLC)1097677622

s— o

Exit




Merge Record & Combine

10. Click Back to results

Bibliographic

LDR
001
s
08
020

i 035

100

245
%64 1

You have 4 warning(s) in your record - Draft saved at 2:01:42 PM.

Woarking on - THE YOGA TEACHER MEN (891059020319304801), Created by

Inventory Workflow

adminpsb@01SUNY_ESC (12/16/2019 11:52:00 EST), Modified by adminpsb@01SUNY_ESC LDR 01175cam#a22003858i#4500
(1211612019 14.01:22 EST) 001 3910590195 18104801
00289nam#a22001097u#4500 005 0191024012830 0
991059020319304501 008 190201520204 enkHHHERE##H00 04 (Henght
20191216140122.0 010 $5a #£2019004539
191216520 204 HbocsH#R R0 0 04 0#engd 019 $5a 1097677622
$5a 9781767751262 020 $5a 9781787751262
$5a (QCoLC)1084631063 020 $5a 1767751260
$5a Glenny, Jess 020 $3z 9781787751279 (ebook)
$5a THE YOGA TEACHER MENTOR 035 $5a (OCoLC)1084631063 53z (0CoLC)1097677622
$3b Jessica Kingsley Publishers, $5c 2020 035 $3a (OCoLC)on1084631063
040 $5a DLC $5b eng $$e rda $5c DLC $5d OCLCO $5d OCLCF $5d YDX 55d BDX
042 $%a pce
049 $5a ZBMM

o—

0500 0 $3aRA781.7 $%b .G54 2020

ack fo results Edit T Execute

11. Click Edit from the NZ bib record on the right-side of the MD Editor

File ~

Bibliographic

LDR
001
005
008

Edit ~

Tools ~

You have 4 warning(s) in your record - Draft saved at 2:01:42 PM.

Working an - THE YOGA TEACHER MEN (991059020319304801), Created by
adminpsb@01SUNY_ESC (12/16/2019 1152 00 EST), Modified by adminpsb@01SUNY_ESC
(12/16/2019 14.0122 EST) 1
00289nam#a22001097u#4500

991059020319304801

20191216140122.0

191216520 204 hodRHH##rREH0 0 0#0 #engHd

| S

Matches(1)

The yoga teacher mentor / (991059019518104801)

By Glenny, Jess, (Book Jessica Kingsley Publishers,, London ;, 2020)
ISBN: 1787751260

Subjects: Yoga teachers., Yoga—Study and teaching.

Other System Number: (OCoLC)on1084631063, (0CoLC)1084631063
(OCoLC)1097677622

—

Exit




Merge Record & Combine Inventory Workflow

12. Click Tools>MARC Bibliographic>Merge Record & Combine Inventory

File v  Edit v | Tools= | ] B =3 I Kl 2 | | Exit
You have 4 warnir Q 1:42 PM.
1 Q 991059020319304501). Created b Working on - The yoga teacher men (991059019518104801), Created by
W o var o 21U 4 ). Lreated by Bibliographic| adminpsb@01SUNY_ESC (10/24/2015 13:23:58 EDT), Modified by System (10/24/2019 13:28:32
Bbliogiaphic) ac & View versions of original record 155 4 £7) "Modified by adminpsb@01SUNY_ESC : = e - < b
|r1 H g | i
| Validate Cirk+U | ow 01175cam#a22003858#4500 P
LDR OO Valdat e 991059019518104801 i
001 991 Browse Alt+C 001 10590135
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. View Notes . 008 19020 1520 204 enksis( 0 04 (#en g
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008 View Collections ¢ 010 $%a ##2019004539
020 53
Release All Records for User 019 $5a 1097677622
035 58
Test external records 020 $5a 9781787751262
as 100 1 85 -
pis s, | MARC Bibliographic »| Derive New Record 020 $5a 1787751260
264 1 88 wm ’ I Merge Records & Combine Inventory P 020 $5z 9781787751279 (ebook)
Dublin Core Add Holdings Ctri+Alt+H 035 $5a (OCoLC)1084631063 5%z (OCoLC)1097677622
Set Management Tags » ) .
: ; 035 $5a (OCoLC)on1084631063
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Merge Record & Combine Inventory Workflow

13. Merge Records & Combine Inventory

Merge Records & Combinge Inventory

Screen opens You are about to merge record (MMS ID: 991059020316804801)
_ with the record (MMS 1D: 991059020316704801).
a) Choose merge routine: [select Choose bverlay all fields but local .
Overlay all fields but local] merge
routine
b) Click Show merge preview Show merge preview h
You are about to move the following:
c) Update Holdings call number: gghfi;&a' itET'isir- A
igital remote representations(s)
[DO NOT CH ECK] 0 digital representations(s)
0 PO line(s)
d) Secondary record: [select Delete] 0 electronic portfolio(s)
. 0 electronic collection(s)
e) Click Ok

0 Record(s) related to the secondary record might get affected by
the process

Update holdings call number

NOTE: Campus holdings from the

] Secondary record: *Delete Suppress Keep it
Seconda ry record W|” be moved tO the Mote that inventory of the following member institutions will be
primary record (former br|ef b|b) moved to the primary record: SUNY Geneseo.

Mote: this operation is non-reversible!

* Ok Cancel




Merge Record & Combine Inventory Workflow

14. Click File>Save and Release Record
15. Click Back (<)

File ~ | Edit~  Tools ~
Mew 2
I Save Draft Ctrl+Alt+5
g Save Record Ctrl+5

Save and Release Record Ctri+AR+R 1

@ Duplicate ‘*
—

—

# Institution o Network

Sort by : Rank ~

A% Community

Secondary Sort by - Rank ~

1 & The yoga teacher mentor / Jess Glenny.
Book {Book - Physical} text; unmediated; volume By Glenny, Jess,
(London ; Jessica Kingsley Publishers, 2020.) ISBN: 9781787751262 and others
Subject: Yoga—-Study and teaching. Yoga teachers. Record number: (OCoLC)1084631063
Creation Date: 12/17/2019 09:35:29 EST ¥
Modification Date: 12/17/2019 10:45:00 b

Language: English

Expand =

B O

Edit Record Holdings

MMS ID:
996350359404825

¥ 7@ Physical (1) 14 | All Titles (1-10of 1) I where (Title contains keywords "the yoga

teacher mentor® AND Linked Institution not equals "Community")

£+ Institution 2% Community

Sort by : Rank ~ Secondary Sort by : Rank ~

Primary record (former brief)

only remains

Expand ~ (Y

1 #4 The yoga teacher mentor / Jess Glenny.

Book {Book - Physical} text; unmediated; volume By Glenny, Jess,
(London ; Jessica Kingsley Publishers, 2020.)

Subject: Yoga—-Study and teaching. Yoga teachers.
Creation Date: 12/17/2019 09:31:48 EST
Modification Date: 12/17/2019 10:44:50 EST

Held by (1) Other details

Edit Record  Order
ISBN: 9781787751262 and others

Record number: (OCoLC)1084631063
¥

Language: English

MMS ID:
991059020318904801

9]




Merge Record & Combine Inventory Workflow

16) Change Bib Reference for the POL
a) Click on the number next to Orders

1 & The yoga teacher mentor / Jess Glenny. Edit Record  Holdings
Book {Book - Physical} text; unmediated; volume By Glenny, Jess, Language: English ™ Orders: 1 «
(London ; Jessica Kingsley Publishers, 2020.) ISBN: 9781787751262 and others MMS ID:
Subject: Yoga-Study and teaching. Yoga teachers. Record number: (OCoLC)1084631063 096350356404825
Creation Date: 12/18/2019 21:59:20 EST ¥
Modification Date: 12/18/2019 22:15:22 EST I:E

¥ Physical (1) Other details

b) Click Change Bib Reference

THE YOGA TEACHER MENTOR, Jessica Kingsley Publishers,, 2020, 9781787751262, ISBN ﬂmme Bib Reference ===
MMS ID: 996350356404825 Copies: Library and Learning Resource - On Order Receiving note: -

Assigned to: - (M Sent date: 12/18/2019

Type: Print Book - One Time Total price: 0.00 USD At least one of the reporting codes is

PO line owner: Library and Learning Funds: - missing

Resource Vendor/Account: EBSCO / EBSCO EBSCO L\\—y

Standard number: 9781787751262 Vendor reference ID: -

PO: PO-769 / (Sent) Expected delivery: 12/18/2019

PO line: POL-2487 / (Sent)

hd Physical One Time (1)




Merge Record & Combine Inventory Workflow

16) Change Bib Reference for the POL
C)

Click Confirm when the Confirmation Message pops-up

Confirmation Message

PO Line's description - Are you sure you want to perform this action?

PO Line 'POL-2487" will change the link to the bibliographic record - this change will not impact the inventory and will only update the

e

l
Zone: @ M Institution £ Network 22 Community X
Title - Contains Keywords - The yoga teacher mentor / O X
m OR ISBN - Contains Keywords - 1787751279 Q@ 1 X
 Institution wa Network 2t Community
1-1o0f1 Expand -~
1 &% The yoga teacher mentor / Jess Glenny.
Book {Book - Physical} text; unmediated; volume By Glenny, Jess, (London ; Language: English ™ Orders: 1 h
Jessica Kingsley Publishers, 2020.) ISBN: 0781787751262 and others MMS ID:
Subject: Yoga—Study and teaching. Yoga teachers. Record number: (OCoLC)1084631063 ¥ 996350356404825

Creation Date: 12/18/2019 21:50:20 EST
Modification Date: 12/18/2019 22:15:21 EST

e Physical (1) Other details




Merge Record & Combine Inventory Workflow

16) Change Bib Reference for the POL
e) The POL title has changed to match the bib record

< Purchase Order Lines (1-10f1) Back

Al ~ Q B ©
The yoga teacher mentor / Jess Glenny., London ;, Jessica Kingsley Publishers,, 2020, 9781787751262, ISBN Edit  Change Bib Reference
MMS ID: 996350356404825 Copies: Library and Learning Resource - On Order Receiving note: -
Assigned to: - ) Sent date: 12/18/2019

Total price: 0.00 USD At least one of the reporting codes is
Funds: - missing

Type: Print Book - One Time
PO line owner: Library and Learning

Resource Vendor/Account: EESCO / EBSCO EBSCOD
Standard number; 9781787751262 Vendor reference ID: -
PO: PO-769 / (Sent) Expected delivery: 12/18/2019

PO line: POL-2487 / (Sent)

Physical One Time (1)

e) Click Back (<)




TROUBLESHOOTING: WHAT TO DO
IF A DUPLICATE BIB RECORD IS
CREATED IN THE NZ




Troubleshooting

m A duplicate bib record will be created after adding the OCLC # and saving the brief
bib record if No is clicked when the Confirmation required box appears asking;:
“Matched record(s) exist in the catalog, do you want to view them before saving”

Confirmation required

: Matched record/s exist in the catalog,

F  doyou want to view them before saving?
Yes | o []

If you accidentally create a duplicate bib record in the NZ after updating a NZ brief bib
record you can either:

1. Merge Record & Combine Inventory
2. Relink from the POL




Troubleshooting - Merge Records & Combine Inventory

1. Click Edit Record from the brief bib record

1 & THE GENIUS OF YOGA # EditRecord  Holdings
Book {Book - Physical} By Finger, Alan (Shambhala 2020) Language: English ™ Orders: 1
Creation Date: 12/18/20109 20:59:54 EST ISBN: 9781611808049 MN_'IS ID:
Modification Date: 12/18/2019 20:59:54 EST Record number: (0CoLC)1122799125 996350356704825
Physical (1) Other details

Click on the Save icon (Ctrl+S)

3. Click Yes when the Confirmation Required message appear asking if you want to
view matched records before saving

Confirmation required

Matched record/s exist in the catalog,
I do you want to view them before saving?

By, Y No

4. Follow steps 9-15 under “Merge Record & Combine Inventory for NZ Brief Bib
Records Workflow” above




Troubleshooting - Relink from the POL

1. Perform an IZ repository search for the brief bib

2. Click the number next to Orders

m ISBN -~ 9781611808049 ﬂ'n Advanced v

< AllTitles(1-10f1) 9781611808049

Save Query

 Institution a'n Network At Community

Sort by : Rank ~ Secondary Sort by - Rank - Expand = (S Lo

1 && THE GENIUS OF YOGA Edit Record  Holdings

Book {Book - Physical} By Finger, Alan (Shambhala 2020} Language: English ™ Orders: 1

Creation Date: 12/18/2019 20:00:40 EST ISBN: 9781611808049 MMS ID:

Modification Date: 12/18/2010 20:02:34 EST Record number: (0CoLC)1122799125 996350357004825
Physical (1) Other details




Troubleshooting - Relink from the POL

3. Click Edit

THE GENIUS OF YOGA, Shambhala, 2020, 9781611808049, ISBN * Edit ~ Change Bib Reference
MMS ID: 996350357004825 Copies: Library and Learning Resource - On Order Receiving note: -
Assigned to: - o Sent date: 12/18/2019
Type: Print Book - One Time Total price: 0.00 USD At least one of the reporting codes is
PO line owner: Library and Learning Funds: - missing
Resource Vendor/Account: EBSCO / EBSCO EBSCO
Standard number: 9781611808049 Vendor reference ID: -
PO: PO-764 / (Sent) Expected delivery: 12/18/2019
PO line: POL-2483 / (Senf)
Physical One Time (1)
4. Click Relink
¢{ Purchase Order Line Details Save as template Replace (only) Vendor Change Bib Reference C-wa“ Relink Back m
THE GENIUS OF YOGA, Shambhala, 2020, 9781611808049, ISBN O -
PO line POL-2483 PO PO-764 Status Sent (2019-12-19)
PO linetype  Print Book - One Time PO line owner Library and Learning Resource Sent date 12/18/2019




Troubleshooting - Relink from the POL

5. Click on the Network tab

6. Click on the title to relink the POL and associated inventory

Repository Search @

Zone: M Institution | @ && Network 2& Community X

Title - Contains Keywords d THE GENIUS OF YOGA Q h X

m OR ISBN - Contains Keywords d 1611808049 Q h X

- Institution aw Network 2t cCommunity

Sort by : Rank - Secondary Sortby : Rank ~ 1-20f2 Expand - t 43

1 # THE GENIUS OF YOGA

Book {Book - Physical} By Finger, Alan (Shambhala 2020) ISBN: 9781611808049 Language: English
Creation Date: 12/18/2019 19:58:08 EST Record number: (OCoLC)1122799125 MMS ID:

Modification Date: 12/18/2019 20:02:34 EST £91059020316004801

Held by (1) Other details
2 The genius of yoga : how yogic meditation can unlock your innate brilliance / Alan Finger and Peter Ferko.

Book {Book - Physical} text; unmediated; volume By Finger, Alan, (Boulder, ISBN: 9781611808049 and others Language: English
Colorado : Shambhala, [2020]) Record number: (0CoLC)1122799125 ¥ MMS ID:

Subject: Meditation. Mindfulness (Psychology) Yoga. 991059020316204801

Edition: First edition. _
Creation Date: 12/18/2019 17:41:59 EST

Modification Date: 12/18/2010 18:10:22 EST

Other details




Troubleshooting - Relink from the POL

7. Click Confirm when the pop-up confirmation message appears

-
Confirmation Messame
PO Line '‘POL-2483" will be linked to 'The genius of yoga : how yogic meditation can unlock your
innate brilliance / ISBN: 1611808049, 1 item will be moved.
4
|

8. Click Back
9. Click Edit Record from the NZ brief bib record

1% THE GENIUS OF YOGA ﬂscmmm Order

Book {Book - Physical} By Finger, Alan (Shambhala 2020) Language: English MMS ID:
Creation Date: 12/18/2010 20:00:40 EST ISBN: 9781611808049 996350357004825
Modification Date: 12/18/2010 20:02:34 EST Record number: (OColLC)1122799125
Other details
2 & The genius of yoga : how yogic meditation can unlock your innate brilliance / Alan Finger and Peter Ferko. EditRecord  Holdings
Book {Book - Physical} text; unmediated; volume By Finger, Alan, Language: English ™ Orders: 1
(Boulder, Colorado : Shambhala, [2020]) ISBN: 0781611808049 and others MMS ID:
Subject: Meditation. Mindfulness (Psychology) Yoga. Record number: (0CoLC)1122799125 996350356804825
Creation Date: 12/18/2019 20:39:09 EST ¥

Modification Date: 12/18/2019 20:39:09 EST
Edition: First edition.

Physical (1) Other details




Troubleshooting - Relink from the POL

10. Copy the NZ MMS ID from MARC field 001 | o [osmaraniies
. _ |on1 991059:-20316004801|¢ NZ MMS ID
a) The NZ MMS ID will be used to report the bib 005 201912182002250
. 008 191218s20 20 bocrtE R0 00#0#eng#d
record for deletion e
. - $%5a (OColLC)1122799125
11. CIICk Flle>COpy tO Catalog - ‘1}2; 1 %%5a Finger, .-’-:Ian
a) This unlinks the bib record from the NZ and S

creates and IZ bib record
12. Click on the Save icon (Ctrl+S)

13. Click File>Delete Record f“”ﬂ”“;””t'f”:iff —
Ou are about to delele the Tollowing Diohographic
a) This deletes the 1Z bib record only record:

Title: THE GENIUS OF YOGA

. . . . ID: 996350357004825
14. Click Save when the Confirmation required e

message asking if you are sure you want to delete Are you sure ?

the record s Vs e

15. Click Back (<)




Troubleshooting - Relink from the POL

16. Report the NZ brief bib record to be deleted to the NZ

Coordinator
) Goto libguides
https://slcny.libguides.com/overview

b) Click on Communication Channels
c) Click Forms and Contacts for SLSS | Forms and Contacis for SLSS v

d) Click on Request to Deleted NZ Bib Records

Request Forms In-Person Workshops and Meetings

Migration

« OCLC Master Record Change Request Form

This form is used to request the SL33 makes changes to the OCLC master records on hehal
changes for themselves

« Reguest to Delete NZ Bib Records h

se this link to request deletion of an NZ bib record you have created in error.

« Reguest to Suppress Dedup/FRER

For Campuses interested in suppressing dedupfrbr in Primo VE for Special Collections.



https://slcny.libguides.com/overview

SUPPORTING DOCUMENTATION




Supporting Documentation

m Relinking Bib Records Session by Maggie McGee 7/30/2019

m Ex Libris Documentation: Merging Bibliographic Records



https://public.3.basecamp.com/p/3qQWjiyBueXUQdu53V7YWgi3
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alma_Online_Help_(English)/040Resource_Management/040Metadata_Management/040Working_with_Bibliographic_Records#Merging_Bibliographic_Records

